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Product and Company Information 

The information in this document is confidential proprietary information belonging solely to Constellation 

HomeBuilder Systems, Inc., a wholly owned subsidiary of Constellation Software, Inc. This document is 

supplied under a license and may not be reproduced, published, or disclosed without prior written 

authorization. Constellation licenses its program products (software) to the customer in accordance with 

the terms and conditions of the BuildTopia Software License Agreement. No title or ownership of the 

BuildTopia software is transferred. Any use of the software beyond the terms of the aforesaid license, 

without the prior written authorization of Constellation, is prohibited.  

 

 

The names of companies, products, people, characters and/or data mentioned in screens, reports, and 

other data examples are fictitious and are in no way intended to represent any real individual, company, 

product or event, unless otherwise noted. Any rights not expressly granted herein are reserved.  

 

 

Trademark and Patent Information  

Other product and company names mentioned herein might be the trademarks of their respective owners.  

 

 

Disclaimer of Warranties and Limitation of Liabilities  

The staff at Constellation has taken due care in preparing this information; however, nothing contained 

herein modifies or alters in any way the standard terms and conditions of the BuildTopia License 

Agreement by which the product was acquired. Nor does it increase in any way Constellation’s liability to 

the customer. In no event shall Constellation or its affiliates be liable for incidental or consequential 

damages in connection with or arising from the use of the product, the accompanying documentation, or 

any related materials.   
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Contacting Support and Services  

Support for the BuildTopia software is available at Constellation’s Baltimore and Markham offices.  

 

 

Baltimore Main Office  
Telephone:  1 410 843-3800 

Fax:   1 410 843-3853  

Web:  http://www.constellationhb.com  

 

 

Support Desk  
Support Desk assists with software operations.  

 

Telephone: 1 800 411-2020 Option #4 

Email:  support@buildtopia.com  

Hours: Monday through Friday 9:00 a.m. to 5:00 p.m. (Eastern Standard Time) 

 

Professional Services  

Contact your company’s Professional Services Consultant for assistance with software implementation, 

training, consulting, and data building. 

  

Telephone: 1 905 475-2209 or toll-free at 1 888 723-2222  

Fax:  1 905 475-7204  

Web:  http://www.constellationhb.com 
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Enhancements 

This section highlights new features and enhancements that have been added to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 

description of the item with any relevant screenshots to detail the enhancement. 

 

Update of the default for the Price Options screen in Sales Management to ‘Don't Apply’ 

Defect #:  001-00-1-12198 

Ticket #:  001-00-206792 

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Management > Price Options > Edit Option Prices > Select Category 

The default for the Price Options screen in Sales Management has been changed to ‘Don't 
Apply.’ This was requested by multiple users to prevent unintentional price updates. 

Screenshots:  

Sales Management > Price Options > Edit Option Prices > Select Category 

 

Updates to the Broker Agent and Mortgage Company lists in Sales Rep 

Defect #:  001-00-1-12393, 001-00-1-12394 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Sales Rep > Broker Agent/Mortgage Co List > Broker Agents tab 

Sales Rep > Broker Agent/Mortgage Co List > Mortgage Companies tab 

Broker Agent names on the Broker Agents list ins Sales Rep can now be clicked to go to 

View page. Similarly, Loan Officer names on the Mortgage Companies list in Sales Rep can 
now be clicked to go to View page. 

Screenshots:  

 

Sales Rep > Broker Agent/Mortgage Co List > Broker Agents tab 
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Sales Rep > Broker Agent/Mortgage Co List > Mortgage Companies tab 

 

  

Updates to the Broker Agent and Mortgage Company lists in the Directory 

Defect #:  001-00-1-12391, 001-00-1-12392 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Directory > Broker Agents 

Directory > Mortgage Companies 

Broker Agent names on the Directory > Broker Agents list can now be clicked to go to 

View page. Similarly, Loan Officer names on the Directory > Mortgage Companies list can 

now be clicked to go to View page. 

Screenshots:  

Directory > Broker Agents 

 
 

Directory > Mortgage Companies 
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Addition of Select/Clear all check boxes to the ‘Do Not Bid’ and ‘Taxable’ columns on the Edit 

Unit of Measure page 

Defect #:  001-00-1-12502 

Ticket #:   

Product:    BTBuilder             BTSales              BTService              BTLead 

Description:   Bidding & Contracting > Bids > Unit of Measure > Edit 

Select/Clear all check boxes have been added to the ‘Do Not Bid’ and ‘Taxable’ columns on 
the Edit Unit of Measure page. 

Screenshots:  

Bidding & Contracting > Bids > Unit of Measure > Edit 

 

Usability updates to the Base and Option tabs on the Proforma Budget pages 

Defect #: 001-00-1-12263 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Bidding & Contracting > Proforma Budgets > Base 

Bidding & Contracting > Proforma Budgets > Options 

The following updates were made to the pages above to help improve ease of navigation: 

- The Activity Code/Activity Package column has been broken up into 3 columns: Activity 
Package, Activity #, and Activity Name. 

- A new column, ‘Status’, has been added to show the activity status. 

- A new filter, ‘Status’, has been added to filter by activity status. 

- A new filter, ‘Activity Package’ has been added to filter by the activity packages available 
on the selected plan. 

- The order of columns has been changed to; Trade, Activity Package, Activity #, Activity 

Name, Scope of Work, Status, Current Proforma, Revised Proforma. 

- The 'Type' filter has been removed (referred to Activity Package type). 

 

On the Option tab only: 

- The order of columns has been changed to; Category, Option, Trade, Activity Package, 

Activity #, Activity Name, Activity Status, Current Proforma, Revised Proforma. 

- Change the name of the column 'Option Code to' 'Option'. 
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Updates to the filters on the To Do List in Sales Rep 

Defect #: 001-00-1-12311 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Management > To Do List 

The following updates have been made to the To Do List in Sales Rep based on feedback: 

- When the pre-defined date ranges are chosen (Today, Yesterday, Tomorrow, Next 7 

Days, Next 30 Days), the date fields below show the actual dates for the date range and 
cannot be updated manually.  

- When the date range 'Custom' is chosen, the date fields can be updated manually. 

- When the date range 'Custom' is chosen, the 'Hide Overdue Tasks?' button is inactive so 
that only the tasks within the selected dates are displayed. 

Update of wording on the Opt-Out Rule sales settings 

Defect #: 001-00-1-12641 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Admin > Company Setup > Sales Settings 

The wording on the Opt Out Rule sales settings has been updated to clarify the 
functionality: 

- Updated from 'Delete' to 'Exempt - If a prospect opts out of a certain task type (Emails, 
Letters, and/or Phone Calls) campaign tasks of that type will not be created for them' 

- Updated from 'Dismiss' to 'Dismiss - If a prospect opts out of a certain task type (Emails, 

Letters, and/or Phone Calls) campaign tasks of that type will be created for them, but 

immediately marked as Dismissed' 

- Updated from 'No Opt Out' to 'No Opt Out - the Opt Out options will not be available for 
prospects. 
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Defect Fixes 

This section highlights corrections and defect fixes that have been applied to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 
description of the item with any relevant screenshots to detail the defect. 

 

Notification when the Generate All Letters/Emails links when there no tasks 

Defect #: 001-00-1-12324 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Management > To Do List 

An error message was sometimes shown when the ‘Generate All Letters’ and ‘Generate All 

Emails’ links were clicked but there were no open letter/email tasks on the list. The 
following messages will now be shown: ‘There are no letters/emails to be generated.’ 

 

Issue with the document types available for email and Autosend email tasks for prospects 

Defect #: 001-00-1-12396 

Ticket #: 001-00-208897 

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Prospects > Tasks > Add Task 

Sales Rep > Prospects > Tasks > Task Name (Edit) 

When manually creating or editing an Email or Email (Autosend) task for a prospect, 

clicking on the magnifying glass shows a list of documents. The list incorrectly displayed 
other types of email documents. This has been corrected to display Sales Emails only. 

 

Issue with the Prospect Survey 

Defect #: 001-00-1-12561 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep: Prospects > Survey 

When completing the survey for a prospect, if a required field was left blank, or no answer 

is selected, and 'Save' was clicked, all the answers completed for all the questions on the 
survey were cleared. This has been corrected so that answers are not lost. 

 

Issue with the Taxable field for Unit of Measure bids in Trade Partner accounts 

Defect #: 001-00-1-12492 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Trade Partner Account: Bids > Unit of Measure > Edit 

The Taxable field for Unit of Measure bids has been corrected on Trade Partner accounts 
and is now no longer editable. 
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Issue when prospect letter tasks have documents that have tag errors 

Defect #: 001-00-1-12592 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > To Do List 

Sales Rep > Prospects > Tasks 

An error message was shown when trying to generate a prospect letter task, but the letter 
has tag errors. Going forward the tag errors on the document will be displayed. 

 

Issue with the Project State field on the Edit Company Info page 

Defect #: 001-00-1-12312 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Admin > Company Info > Edit 

The choices shown for the Project State/Province field were not dependent on the selection 

made for the Country field. This issue has been corrected; American states will be shown 

when USA is selected, Canadian Provinces when Canada is chosen, and no options when 
any other country is chosen. 

 

Correction to the ‘Project Type’ field for Critical Dates (Ontario projects only) 

Defect #: 001-00-1-12231 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Admin > Projects > View 

Admin > Projects > Edit 

A correction has been made to the project field called ‘Project Type’ for Tarion Critical 

Dates functionality. It will only show on the Project View and Edit screens when the Project 
province is Ontario and Country is Canada. 

 

Issue with phone numbers when editing Broker Agent and Mortgage Company information 

Defect #: 001-00-1-12476 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Directory > Broker Agents > Edit 

Directory > Mortgage Companies > Edit 

Sales Rep > Broker Agent/Mortgage Co List > Broker Agents tab > Edit 

Sales Rep > Broker Agent/Mortgage Co List > Mortgage Companies tab > Edit 

Phone numbers saved in the Phone Number 1 and Phone Number 2 fields for Broker 

Agents and Mortgage Companies were cleared when editing a Broker Agent or Mortgage 
Company record. This has been corrected. 
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Issue with phone and fax numbers when editing users in Trade Partner accounts 

Defect #: 001-00-1-12482 

Ticket #: 001-00-208878, 001-00-209711 

  BTBuilder             BTSales              BTService              BTLead 

Description: Trade Partner account: Admin Users > Edit 

Admin > Company Information > Edit Company Info  

Admin > Company Information > Edit Remittance Info 

In Trade Partner accounts, when editing user information, company information, or 

remittance information, when any of the required fields was left blank the values in the 
Phone and Fax Number fields were cleared. This has been corrected. 

 

Error message when adding a co-prospect 

Defect #: 001-00-1-12671 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Prospects > Prospect Summary > Add Co-prospects 

In some situations an error message was shown when adding a co-prospect. This has been 
corrected. 

 

Issue with dismissed prospects tasks 

Defect #: 001-00-1-12712 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Prospects > Tasks > Task History > Task Name 

The assigned sales rep on dismissed tasks could be edited by going to the view page for 

the task. This has been corrected. Only notes can be edited on dismissed tasks. 

 

Addition of plan information at the top of the Admin > Project > Plans > Lots page 

Defect #: 001-00-1-12522 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Admin > Projects > Plans > Lots 

The plan name, number, and bedroom/sqft information was missing at the top of this 
page. This has been corrected. 
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Issue with display of plans on the expanded view of Lot information on the Lot List page in 

Sales Rep 

Defect #: 001-00-1-12741 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Prospects 

To prevent confusion the ‘Delete’ link will not be shown on the SR > Prospects list for co-

prospects. Co-Prospects can still be managed from the prospect summary screen. Deleting 

a prospect from the Prospects list will delete associate prospects as well. 

 

Issue with display of plans on the expanded view of Lot information on the Lot List page in 

Sales Rep 

Defect #: 001-00-1-12605 

Ticket #: 001-00-209160 

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > Lot List 

When the 'Expand All' button or the expand triangles for individual lots were clicked on the 
page, the available plans for the lot were not displayed. This has been corrected. 

 

Correction of the date format on the Create Date column on the SPEC List in Sales Rep 

Defect #: 001-00-1-12642 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Sales Rep > SPEC List 

The date format on this page has been corrected. 

 

Issue when clicking on the ‘Home’ link on the navigation link when on the Documents page 

Defect #: 001-00-1-12662 

Ticket #:  

  BTBuilder             BTSales              BTService              BTLead 

Description: Home > Documents 

An error message was shown when clicking on the ‘Home’ link on the navigation link when 

on the Documents page. This has been corrected. 
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BuildTopia Product Roadmap 

These are some of the new features and enhancements scheduled for future releases in 2013. This 

information is not a complete list of all features that will be in the releases, and is subject to change. If 

you have any suggestions in these areas, please contact the Customer Support Desk.  

  

Version 6.4.0, Release date July 23rd 2013 

Focus – Sales and Bidding & Contracting 

 

• Improve cross-project functionality for updating information in Bidding and Contracting 

• Combine Sales Rep and Sales Management modules, with advanced permissions 

• Improved sales incentives functionality. 

 

Version 6.5.0, Release date November 12th 2013 

Focus – User interface re-design 

 

• Updated design theme 

• Improved, intuitive workflows 

• Tablet browser friendly screens. 


